
1Copyright 2022 Julieanne Kost All Rights Reserved. 

01. Working with Panels, Sliders and Tools 2

02. The Filmstrip 2

03. Adding Ratings and Labels 2

04. Zooming and Panning Images 2

05. Navigating Through a Document Screen By Screen 3

06. Multiple Undo 3

07. Crop, Straighten, and Rotate Tools 3

08. Edit 4

09. Profiles 4

10. The Histogram 4

11. The Basic Panel 4

12. The Curve Panel 5

13. The Detail Panel 5

14. Color Mixer / B&W Mixer Panel 6

15. Color Grading Panel 6

16. Optics Panel 7

17. Geometry Panel 7

18. Effects Panel 7

19. The Healing Tools 8

20. Masking and Local Adjustments Tools  8

21. Snapshots Panel 10

22. Red Eye Removal Tool 10

23. Presets Panel 10

24. Color Sampler Tool 11

25.  Grid Overlay 11

26. Soft Proofing 11

27. Before and After Previews Options 11

28. Save Image Options 11

29. Workflow Options 11

30. Enhance Details and Super Resolution 12

31. Syncing Edits Across Images 12

32. Merge to HDR  13

33. Merge to Panoramas 13

34. Merge to HDR Panoramas 13

35. Camera Raw Preferences  14

36. Using Camera Raw without Photoshop 14

37. Bypass Camera Raw when Opening From Bridge 14

38. Applying Camera Raw Presets in Bridge 14

ADOBE CAMERA RAW SHORTCUTS
JULIEANNE KOST



2Copyright 2022 Julieanne Kost All Rights Reserved. 

01. Working with Panels, Sliders and Tools
• Tap F to toggle Full Screen Mode. 

• Command + 1, 2, 3-9 (Mac) | Control + 1, 2, 3-9 (Win) displays the corresponding edit panel (Basic, Curve, Detail etc.). 

• To reorder, hide, and show panels, right -click (or Command -click on Mac), on a panel header and choose “Edit Panels to Show”. Use the up 

and down arrow keys in the subsequent dialog to change the stacking order. 

• Double click the slider handle to reset the slider.

- To reset all sliders in a panel, hold Option (Mac) | Alt (Win) and click Reset (PanelName).

- To reset all slider adjustments made to an image, click the More icon (the three dots) and choose between Reset to Open and Reset to Default.

- For more precision when dragging sliders, click -drag the left side of the panel stack to expand the width of the panel track.

- Several panels have additional options which can be accessed by clicking on the white progressive disclosure triangles within the panel. 

• Click in any text entry area to enter specific numeric values. Tap the Tab key to move to the next text entry. With the text entry highlighted, 

use the up/down arrow keys to modify existing values. Add the Shift key to modify in larger increments.

• A small white dot to the right of the tool (Edit, Crop & Rotate, Spot Removal etc.), indicates that there have been changes made with the tool(s).

• When viewing Camera Raw lower resolution screens, select Preferences > General > Compact Mode to view more options on screen at one time. 

• Click the Settings (gear) icon and choose Preferences > General (or rt -click (Control -click Mac) on the name of a panel) to select a panel mode:

- Single Panel Mode – displays panel options for one panel at a time – clicking on a panel expands the contents of that panel while collapsing any 

other open panels (useful when working on a smaller display as it eliminates the need to scroll through several open panels to access options).

- Responsive Panel Mode – Camera Raw will intelligently open and close edit panels to automatically fit your monitor.  

- Multi Panel Mode – leaves all opened panels expanded.

02. The Filmstrip
• Tap forward slash (/) to toggle the visibility of the filmstrip. 

• Command + Shift + F (Mac) | Control + Shift + F (Win) toggles the orientation of the Filmstrip. 

• Position the cursor at the top of the Filmstrip (between the image preview area and the image thumbnails) and drag to resize the Filmstrip.

• Position the cursor over a thumbnail in the Filmstrip and click the More icon (the three dots) to access additional options such as Show 

Filenames, Show Ratings & Color Labels (or Control -click (Mac) | right -click (Win) on the thumbnail and use the context sensitive menus).

03. Adding Ratings and Labels
• Use the numeric keys 1-5 to apply star ratings.

• Use the numeric keys 6-9 to apply color labels.

• Command + “,” or “.” (Mac) | Control + “,” or “.” (Win) will decrease/increase star ratings.

• Option + Delete (Mac) | Alt + Backspace (Win) marks an image as Rejected. 

• Tap Delete to mark an image for deletion. Control -click (Mac) | right -click (Win) to unmark via the context sensitive menus.

04. Zooming and Panning Images
• Tap the H key to select the Hand tool.

• With most other tools selected, press the Spacebar to temporarily access the Hand tool. 

• Tap the Z Key to access the Zoom Tool.

• Clicking in the image area with the Zoom tool  toggles the zoom between Fit in View and whatever zoom percentage is shown in the right 

zoom button.

• Command + 0 (Mac) | Control + 0 (Win) will fit the image within the preview area (Fit In View).

• Command + Option + 0 (Mac) | Control + Alt + 0 (Win) will zoom to the percentage set in Preferences > General > Zoom and Pan > Default 

image click zooms to (xxx%).

• Command + Shift -click (Mac) | Control + Shift -click (Win) will zoom to the percentage set in Preferences > General > Zoom and Pan > Default 

image click zooms to (xxx%). 

• Command + “+” (plus) (Mac) | Control + “+” (plus) (Win) zooms in.

• Command + “-” (minus) (Mac) | Control + “-” (minus) (Win) zooms out.

• Command -drag (Mac) | Control -drag (Win) to zoom into a specific area (Box zoom). 

• Click -drag left/right to zoom out/in with the Zoom tool (Scrubby Zoom).

• Option -scroll (Mac) | Alt -scroll (Win) with a mouse to zoom in/out.

• Click -drag left/right to zoom out/in with the Zoom tool (Scrubby Zoom).
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• With most other tools selected, Press and hold Command (Mac) | Control (Win) to temporarily activate to the Zoom tool. Note that you can 

drag click -drag left/right to zoom out/in with the Zoom tool.

• Select a zoom level from the Zoom percentage icon in the lower left. 

• For quick navigation to a specific area, use Birds Eye View: 

- Press and hold the H key. 

- Click-and-hold the mouse down in the image area. The image zooms in and a rectangle appears.

- With the mouse still held down, reposition the rectangle over the area that you want to zoom to. 

- Release the mouse. The image zooms in to the rectangular area. Release the H key (the originally selected tool remains unchanged).

- Note: Birds Eye View is only available when GPU is enabled in the Camera Raw Preferences > Performance > Use Graphics Processor.

• When moving from one image to another in the filmstrip, the zoom percentage and location will stay constant. To vary the zoom between 

images disable Global Zoom Editing from the Zoom Level popup in the lower left. 

• If you prefer the Zoom tool to automatically swap to the hand tool when zoomed into 100%, click the Settings icon (the gear) and choose 

General > Zoom and Pan and enable “Use Lightroom Style Zoom and Pan”. 

05. Navigating Through a Document Screen By Screen
• Tap the Home key to move to the top-left corner of the image. Tap the End key to move to the bottom-right corner of the image. 

• Tap the Page-down key to move down one full screen. When you reach the bottom of the image, tapping the Page-down key again takes you 

to the top and to the right by one full screen. Tapping the Page-up key does the same thing, but in the opposite direction.

Note, on a laptop, use the function key and the left/right arrows to move to the Home/End (top left and bottom right) and the up/down arrows 

to navigate Page Up/Down (screen by screen).

06. Multiple Undo
• Command + Z (Mac) | Control + Z (Win) goes back in time (Multiple Undo). will toggles (Undo/Redo) the last change made.

• Command + Shift + Z (Mac) | Control + Shift + Z (Win) goes forward in time (Multiple Redo).

• Command + Option + Z (Mac) | Control + Alt + Z (Win) toggles the last state off/on (after the most recent command) 

07. Crop, Straighten, and Rotate Tools
• Tap the C key to select the Crop tool.

• When you first select the Crop tool, click and drag in the image area to set the crop or, use the handles to resize the crop. Drag within the 

crop marquee to reposition.

• Option -drag (Mac) | Alt -drag (Win) the crop handles to transform the crop from the center.

• Position the cursor outside of the crop marquee (the icon will change to the double headed arrow), and drag to rotate the angle of the crop.

• Select an aspect ratio from the list or, select Custom and enter values (ACR will save the last 5 custom aspect ratios entered). 

- Tap X to flip the crop aspect ratio (landscape to portrait/portrait to landscape).

- Option + A (Mac) | Alt + A (Win) toggles the lock aspect ratio option

• Tap the A key to select the Straighten tool. 

- Double click the Straighten tool to automatically straighten the image (this works best with images that have a strong horizontal line).

- With the Crop tool selected, hold the Command (Mac) | Control (Win) to temporarily activate the Straighten tool.

• Command + left/right arrow (Mac) | Control + left/right arrow (Win) move from one image to the next while cropping. 

• Command + Option + drag (Mac) | Control + Alt + drag (Win) with the Crop tool to temporarily invoke the Zoom tool. 

• Choose another tool, double-click within the crop marquee, or tap Return (Mac) | Enter (Win) to apply the crop. 

• With the Crop tool selected, Command + Option + R (Mac) | Control + Alt + R (Win) will reset the crop.

• Tap Escape to reset the crop and dismiss the Crop tool.

• The Crop tool is solely responsible for defining the aspect ratio of the crop. Use the Save and Workflow options to determine image size. 

- For example, in order to create an image that is 8 x 10 inches at 300 ppi, crop to a 4x5 crop aspect ratio. Then, when using the Save or Workflow 

options, check Image Sizing, select Short Size from the drop down menu and enter 8 inches and a resolution 300 ppi.

• Tap the V key to view the Crop overlay. Option + V (Mac) | Alt + V (Win) toggles through Overlay styles (or Control -click (Mac) | right -click 

within the crop marquee choose from the list of Overlay Styles). 

• Command -click (Mac) | Right -click (Win) within the crop marquee to access many of the Crop options via the context sensitive menu.

• Tap the R key to rotate an image clockwise or use Command + “[“ (Mac) | Control + “[“ (Win) 

Tap the L key to rotate counter clockwise or use Command + “]” (Mac) | Control + “]” (Win). 
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08. Edit
• Command + U | Control + U (Win) applies Auto Tone to an image. 

• Clicking the B&W icon automatically applies the Adobe Monochrome profile. 

09. Profiles
• Within the Profile browser, double click a profile to apply it and exit the browser. 

• Within the Profile browser, click the Star icon to add the profile to Favorites. Then, use the Profiles drop down list to quickly access Favorites.

• Within the Profile browser, click the More icon to change View options (List/Grid/Type), Reset, Manage, and Import/Export profiles. 

• Many profiles have an Amount slider (although the creator of the profile can  disable the effect of the slider).  Moving the slider to the left 

decreases the strength of the profile: moving the slider to the right, amplifies the strength of the profile. Note: the Raw profiles that Adobe 

ships do not have an Amount slider.

• To customize Camera Raw’s Raw Default settings (in order to assign and manage the default rendering of your raw files across multiple camera 

models check out this blog post (How to Create Custom Raw Defaults in Adobe Camera Raw v12.3).

10. The Histogram
• Control -click (Mac) | Right -click (Win) in the Histogram to enable Lab color readouts.

• Click -drag within the Histogram to adjust the Blacks, Shadows, Exposure, Highlights, and Whites slider adjustments in the Basic tab.

• Tap the U key (underexposed) to preview areas in an image that are clipped to pure black by displaying a blue overlay. 

• Tap the O key (overexposed) to preview areas in an image that are clipped to pure white by displaying a red overlay. 

• The Clipping Warning triangles turn different colors to show that different channels are being clipped:

- If no values are clipped, the triangles are black.

- If values are clipped in all channels, the triangles are white.

- If values are clipped in the red channel the triangles are red.

-  If values are clipped in the green channel the triangles are green.

- If values are clipped in the blue channel the triangles are blue.

- If values are clipped in the red + green channel the triangles are yellow.

- If values are clipped in the red + blue channel the triangles are magenta.

- If values are clipped in the green + blue channel the triangles are cyan.

11. The Basic Panel
• White Balance

- Tap the I key to select the White Balance tool.

- The White Balance Tool’s sample area is dependent on zoom level (zoom in to sample a smaller area).

- Double click the White Balance icon to reset the White Balance to “As Shot”. 

- Camera Raw displays a list of “preset” White Balance settings (Auto, Daylight, Cloudy, Tungsten etc.). This list differs slightly from camera to 

camera. When working with JPEG files, As Shot, Auto, and Custom are the only White Balance menu options. 

- The White Balance values displayed for RAW and JPEG files will differ. The Temperature and Tint sliders will display numeric values from -100 

to +100 for JPEG files as opposed to Temperature (2000-50000) and Tint (-150 - +150) values for RAW files.

- Shift -double click the Temperature or Tint slider handle to apply Auto Temperature and Auto Tint.

- With the Zoom, Hand, Color Sampler,and/or Targeted Adjustment selected, holding the shift key will temporarily activate the White Balance tool.

• Toning (Exposure, Contrast, Highlights, Shadows, Blacks, Whites)

- Command + U | Control + U (Win) applies Auto Tone adjustments to an image (or click the Auto button in the Edit section). 

- Shift -double click the Exposure, Highlights, Shadows, Whites, or Blacks slider handle to apply Auto settings.

- Option -drag (Mac) | Alt -drag (Win) the Exposure, Highlights, Shadows, Whites, or Blacks sliders to preview clipped values in an image on a 

per channel basis.

• Texture can be used to decrease or increase the appearance of “texture” in a photograph while still retaining fine details. 

- Moving the Texture slider to the left will reduce unwanted, medium-sized details (for minimizing skin texture or smoothing surfaces for exam-

ple), while moving the Texture slider to the right enhances medium-sized details in a photograph (for intensifying the texture of foliage or hair 

for example).

• Clarity is biased to increases/decreases midtone edge contrast (not full-range or “overall” contrast).

https://jkost.com/blog/2020/06/rawdefaults-acrv12-3.html
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• Dehaze is based on a physical model of how light is transmitted, estimating the amount of light that is lost due to absorption and scattering 

through the atmosphere. Move the slider to the right to remove the haze, move the slider to the left to add a creative haze effect. 

- Dehaze makes dramatic changes to the shadows and lower portion of the Histogram while only slightly adjusting the highlights. 

- For the best results, set the white balance for the image before using Dehaze. 

- Option (Mac) | Alt (Win) -drag the slider to preview areas that are being clipped to pure black without detail. .

• Vibrance is a relative and biased slider - it increases/decreases the amount of color in an image based on how much color there was to begin 

with and, it adjusts orange, red, and yellow values less than other colors. Vibrance can be very useful when increasing saturation in blue sky, 

green grass etc., while avoiding most shifts in skin-tones. 

• Saturation is an absolute adjustment. Moving the slider to -100 will remove all color from an image, +100 will fully saturate colors in an image. 

Note: You can use a combination of both sliders (Vibrance and Saturation) to adjust colors. For example, you may want to make a negative adjust-

ment using Vibrance to decrease the greens and blues, then increase the entire color palette using Saturation. 

12. The Curve Panel
• Use the icons across the top of the Curve panel to move between Parametric, Point Curve, and individual Red, Green, and Blue channels. or, 

use Option + 1, 2, 3, 4 (Mac) | Alt + 1, 2, 3, 4, to select the Composite, Red, Green, and Blue channel.  

• Command + Option + Shift + T (Mac) | Control + Alt + Shift + T (Win), selects the Targeted Adjustment tool for the Parametric Curve. Click 

-drag up/down in the image area to raise/lower the value clicked upon. 

• Command + Option + Shift + P (Mac) | Control + Alt + Shift + P (Win), selects the Targeted Adjustment tool for the Point Curve.

• When using the Parametric curve: 

- Drag the Highlights, Lights, Darks, and Shadows sliders to lighten/darken the image. 

- To change the tonal range affected of any of these sliders, reposition the dots directly under the curve to adjust the “splits”. 

- Control -click (Mac) | Right-click (Win) in the Parametric Curve grid area to quickly reset regions and splits. 

• When using the Point Curve:

- Command -click (Mac) | Alt -click (Win) in the image area to set a point on the curve. 

- Drag to reposition the point in the Tone Curve panel or use the up, down, left, right arrow keys to precisely reposition the point as necessary. 

- A maximum of 16 points can be added to each curve to make color corrections and/or add creative effects. 

- Select the Red, Green, or Blue Channel Icons (the circles) to adjust the adjust the individual red, green, and blue channels.

- Plus (+) and Minus (-) move between control points on the Curve.

- Tap the D key to deselect the Curve.

- Shift -click to select multiple points in the Curves panel at once. 

- Use the Input/Output text boxes to adjust the value of any selected control point.

- With a point selected, tap Delete to delete individual points on the Point Curve or, click -drag the point off the curve. 

- Control -click (Mac) | right-click (Win) in the Point Curve grid area to access additional options including: Reset Channel, Reset All Channels, 

Copy/Paste Channel Settings, and Show All Curves. 

To save a custom Tone Curve, click the More icon at the bottom of the toolbar and choose Save Settings. Use the disclosure triangle to the right 

of the Curves option to save either a Parametric or Point Curve. Saving the Curve to the default location will enable Camera Raw to display the 

curve in the drop-down menu in the Curves panel (as well as make the custom curve available in Lightroom Classic). The Default locations are:

- Mac (user)/Library/Application Support/Adobe/CameraRaw/Curves

- Win (user)/Application Data/Adobe/CameraRaw/Curves

13. The Detail Panel
• Zoom into 100% to accurately view the effects of Sharpening and Noise Reduction. 

• When sharpening, the amount is the amount of contrast added to edges and the Radius determines how many pixels along the edge are 

effected. The Detail and Masking sliders suppress sharpening in the lower contrast areas of an image. As a rule of thumb, the Detail slider is 

better at suppressing sharpening in high-frequency images such as landscapes while the Masking slider is better when working with portraits.

• Option -drag (Mac) | Alt -drag (Win) the Radius, Detail and Masking sliders (as well as the Luminance sliders in Noise Reduction), to display 

a grayscale preview of the slider’s effect. Previewing the edges of the masks (when using the Detail and Masking sliders), can be helpful in 

determining which option is best for the image that you’re working on.  

• Under Color Noise Reduction, increase the Color Smoothness amount to help reduce low-frequency color mottling in an image.  
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14. Color Mixer / B&W Mixer Panel
• To adjust individual color ranges in an image, use the Color Mixer Panel. 

• Use the Adjust menu to choose between two different ways of visualizing color - Color and HSL. The only feature difference between the two 

visualizations is that the Targeted Adjustment Tool is available when using HSL. 

• Use the Targeted Adjustment tool to click-drag up/down (or left/right) in the image area to increase/decease the color range clicked upon.

- Command + Option + Shift + H (Mac) | Control + Alt + Shift + H (Win) selects Hue.

- Command + Option + Shift + S (Mac) | Control + Alt + Shift + S (Win) selects Saturation.

- Command + Option + Shift + L (Mac) | Control + Alt + Shift + L (Win) selects Luminance.

• When converting images to black and white the panel is automatically renamed B&W Mixer. Use the sliders to convert the way that color 

ranges are converted to levels of gray. 

- Option + Command + Shift + G (Mac) | Alt + Control Shift + G (Win) selects the Targeted Adjustment tool in the B&W mixer. 

15. Color Grading Panel
• The Default view of the Color Grading panel displays 3 color wheels: one for shadows, midtones, and highlights. 

- To limit refinements to the Hue, drag the solid colored dot (handle) on the edge of the wheel or, Command -drag (Mac) | Control -drag (Win) 

the hollow dot within the color wheel to restrict refinements to Hue.

- To limit refinements to the Saturation, drag the hollow dot within the color wheel (Lightroom  displays a soft constraint (spoke) between the 

center and edge) or, Shift-drag to restrict refinement to Saturation. Note: Dragging the dot far enough away from the initially selected spot will 

break the constraint and enable you to select a different Hue and Saturation.

- Option -drag (Mac) | Alt -drag (Win) to enable finer adjustments to both Hue and Saturation (the dot will move it more slowly). Note: Fine 

Adjustment mode does not use the soft-constraint. 

• Drag the Luminance slider (beneath each color wheel) to darken/lighten each color range. Lightening the Shadows and darkening the high-

lights enables color to be added to the black and white pixels in an image.

- While Luminance changes can be applied to an image even without applying a color tint, there are more sophisticated controls in the Basic 

panel for adjusting tones (for example, recovering shadow and highlight information). The Luminance  controls are intended to make color 

grading specific changes and are optimized to adjust the color tinting ranges as changes are made to the Blending and Balance sliders.

• Use the Balance slider to shift the range of values that define the shadows/midtones/highlights. For example, if you apply a blue tint to the 

shadows and want that tint to extend farther into the midtones/highlights, move the Balance slider to the left. If you apply a yellow tint to 

the highlights and want that tint to extend farther into the midtones/shadows, move the Balance slider to the right.

• Use the Blending slider to determine the amount of color blending (crossover/overlap) between the tints assigned to the shadows/midtones/

highlights. With blending set to 0, there is a small amount over overlap to avoid abrupt transitions but each color should remain “pure”. With 

the slider set to 100%, the color tints will overlap (crossover) and create additional colors between shadow/midtones, and highlights. Note: 

Without the blending slider, it would be difficult to control how color is added in the midtones (a lower blending value enables the midtone 

color to stand on its own).

- Option -drag (Mac) | Alt -drag (Win) the Blending slider to temporarily boost the saturation to 100, allowing you to quickly see how the tints 

are mixing as you adjust the Blending.

• To view individual (larger), color wheels, click the Detail View icons at the top of the Color Grading panel (or click the  “peek-a-boo” Color Wheels 

on either side of the panel to move from one Color Wheel to another).

- You can use the same options for adding color tints as the 3-color view, or use the disclosure triangle to use the Hue and saturation sliders.

- In Detail View, while hovering the mouse over the Color Wheels, hold Option (Mac) | Alt (Win) to adjust the Hue using the left/right arrows.

- In Detail View, while hovering the mouse over the Color Wheels, hold Option (Mac) | Alt (Win) to adjust the Sat using the up/down arrows.

- Note: Small dots are added under each detail icon that has adjustments.

• Use the Global color wheel to apply a color tint (and adjust luminance values) to an entire image or, to apply a tint in conjunction with three-

way adjustments. This can be helpful when you like the effect that you have achieved using the other color wheels, but want to increase/

decrease the global Hue/Sat/Luminance.

- The Luminance slider is displayed by default, use the disclosure triangle to view Hue and Sat sliders.

- Click the color swatch to select from the default colors or click -drag with the eyedropper to select a color.  Note: the eyedropper is actually 

recording video when it is selecting a color – this is why (on Mac), Lightroom Classic asks for permission to record video.

- • The Blending and Balance sliders have no effect on the toning applied by the Global wheel.

• Double click within a Color Wheel to reset the Hue and Saturation. Double click on the Luminosity slider to reset it. Double click “Adjust” to 
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reset all sliders. Or, right -click (Control -click on Mac) on a color wheel and use the context sensitive menu to reset the color wheel you clicked 

on, reset all three-way color wheels and/or reset all three-way color wheels plus the Global color wheel.

• Right -click (Control -click on Mac) on an individual color wheel and use the context sensitive menu to Copy the settings of the clicked wheel 

or paste settings copied from another wheel. To copy and paste all color grading settings, select the More Options icon (…) and choose Copy 

Selected Edit Settings (choose Color Grading in the dialog). Then, move to the desired image, select the More Options icon (…) and choose 

Paste Edit Settings.  

• Press and hold the eye icon next to a color wheel to  toggle the visibility of a single Color Wheel. 

• Press the eye icon to the right of the Color Grading header to toggle the visibility of all settings in the Color Grading panel.

16. Optics Panel
• To achieve even vignette when cropping an image, enable “Use profile corrections” to remove vignetting caused by the lens and then, in the 

Effects panel, use the Post-Crop Vignetting options to apply vignetting based on the cropped image. 

• To create your own lens profiles (for unique lens/camera combinations, use the free Adobe Lens Profile Creator Tool. All of the information 

that you need to know is here: https://helpx.adobe.com/photoshop/digital-negative.html

17. Geometry Panel
• For best results, enable “Remove chromatic aberration” and “Use profile corrections” in the Optics panel, before applying Upright Transforms. 

• Rotated crops and manual perspective corrections on existing images will usually interfere with Upright transformations. For this reason, 

selecting one of the Upright modes (with the transform tool) will reset the crop and manual perspective adjustments (Horizontal, Vertical, 

Rotate, Scale, and Aspect controls). Resetting the crop has the benefit of showing the user the maximum amount of image area remaining 

after an Upright adjustment. To preserve these settings, Option + (Mac) | Alt + (Win) -click when choosing an Upright transformation.

• Shift + T selects the Transform tool. 

• The Transform tool will generally work better on raw files because it can take advantage of more reliable metadata (e.g., focal length).

• Shift + G toggles the Grid overlay (Change Grid Size and Opacity using the sliders at the top of the window).

• Shift + L toggles the loupe on/off. Note: displaying the loupe requires GPU support.

• Option -drag (Mac) | Alt -drag (Win) displays a loupe and activates precision cursors (enabling a slower drag for accuracy).

• Tap the V key to toggle the Guided Upright tool’s overlay (the guides). 

• Additional refinements can be made using the Manual Transformations:

- The Aspect slider (in the Transform panel) can help remove vertical and horizontal distortions if an image is overly squished or stretched.

- When using the Transform tool to correct perspective, the resulting image is often cropped in order to avoid displaying blank areas around 

the edges. To help retain necessary information from the original image that would otherwise be cropped use the Scale, X Offset, or Y Offset 

slider in the Transform panel to reposition the image within the canvas. Command + Option | Control + Alt -drag to reposition the image in the 

preview area via the Offset X/Y sliders. Add the Shift key (after starting to reposition the image) to constrain to horizontal/vertical directions. 

• With multiple images selected, Camera Raw will analyze each image individually and apply the necessary Upright perspective corrections.  If 

however, you have a series of related images (such as a sequence of bracketed exposures or a set of time lapse images) for which you need 

the same exact numeric perspective corrections made to each image (because Upright is likely to return a slightly different result on each of 

the images in the selection), first apply the Upright mode to a single image. Then, click the More icon (at the bottom of the toolbar), choose 

“Copy Selected Edit Settings” and use the disclosure icon to the right of Geometry and enable “Upright Transform”. Then, select the other 

images, return to the More icon and choose “Paste Edit Settings”. 

18. Effects Panel
• There are three Post Crop Vignetting Styles:

- Highlight Priority enables highlight recovery but can lead to color shifts in darkened areas of a photo. It is suitable for photos with bright image 

areas such as clipped specular highlights and behaves more like a traditional exposure burn.

- Color Priority minimizes color shifts in darkened areas of a photo but cannot perform highlight recovery. This style also behaves more like a 

traditional exposure burn.

- Paint Overlay similar to an overlay of black or white paint and can be useful when trying to apply even amounts of darkening/lightening. 

• Both Highlight Priority and Color Priority styles include a Highlights slider. Increase the slider’s value to reintroduce contrast in the highlights 

(and avoid muddy areas in images). The sliders effect is most noticeable if the vignetting is applied over bright areas such as highlights in a sky. 

• The Grain effect deliberately varies from image to image to facilitate editing time-lapse and video frame sequences.



8Copyright 2022 Julieanne Kost All Rights Reserved. 

19. The Healing Tools
• Tap the B key to select the last used Healing tool. Shift + B toggles between Content Aware Remove, Heal, and Clone.

• There are three different healing modes:

 - Clone makes an exact copy of an area to patch the unwanted area.

 - Heal sects a source from within the image and adjusts color and tone to match to patch the unwanted area. 

 - Content-Aware Remove - makes up information to patch the unwanted area.  

• Tap the V key to toggle the visibility of the spot overlays.

• Tap [ or ] (left/right brackets) to decrease/increase brush size. Add the Shift key to decrease/increase the feather (clone/heal).

• Control -drag left/right to decrease/increase the brush size. Control + Shift -drag left/right to decrease/increase the feather (clone/heal).

• Use the Opacity slider to decrease the opacity of a retouched spot (to minimize a distracting element instead of removing it). 

• Shift -drag constrains the brush spot to a horizontal or vertical stroke.

• Shift -click connects the selected spot with the new spot via a straight brush stroke (to remove power lines for example).

• Click refresh (or tap the / (forward slash) key) to select new source for existing circle or brush spot.

• To select new source for existing circle or brush spot:

 - Click Refresh in the Healing panel options.

 - Tap the / (forward slash) key

 - For the Heal and Clone modes, Command -drag (Mac) | Control -drag (Win) to create a circle spot and drag to manually define the source. 

 - In the Content-Aware Remove mode, Command -drag (Mac) | Control -drag (Win) in the image area - after setting the source - to manually select 

the source area. Note: the Content-Aware Remove mode doesn’t show icons for the source area like the other two modes.

• Command +click (Mac) | Control +click (Win) on one of the mode icons to deselect the active spot and select the new spot mode.

• Press Delete to delete a selected spot. 

• Option -click (Mac) | Alt -click (Win) on a spot to delete it (the cursor will change to a pair of scissors).

• Option -drag (Mac) | Alt -drag (Win) in the image area over multiple spots to batch-delete.

• Tap the Y key to toggle Visualize spots. Tap “, “or “.” to decrease/increase the visualization threshold. Add the Shift key to move in larger increments

20. Masking and Local Adjustments Tools 
• Tap M to select the mask options. 

• Drag the grabber handle to relocate the Mask panel or, drag and drop it into the Adjustment panel to dock it with the panel. 

• After creating an initial mask, tap “N” to create a new mask of the same type as the currently selected component. Use the Shift key to add a 

new Brush, Linear Gradient, or Radial Gradient component and Option (Mac ) | Alt (Win) to subtract a component. For example, Shift + K adds 

a brush component to the current mask, and Option +K (Mac ) | Alt +K (Win) subtracts a brush component from the current mask.

• Hold Shift to toggle the Add and Subtract buttons in the masks panel to Intersect (or, use the More Options icon (…) to select the “Intersect 

Mask With” command). Note: Intersect automatically creates a mask component in Subtract + Invert mode. 

• By default, Camera Raw resets the sliders for each new adjustment. To keep the same adjustments, at the bottom of the Masks Settings panel, 

uncheck the “Reset Sliders Automatically” option.

• Command + Option + R (Mac) | Control + Alt + R (Win) resets the adjustment sliders options for the tool.  

• Tap “X” to invert a mask.

• Use the “Preset” drop-down menu (in the Mask Setting panel) to save presets for frequently used settings. 

• Use the Amount Slider to decrease/increase the slider adjustments for a mask (each slider will be adjusted relative to it’s setting).

• Press the Delete key to delete the selected mask component. 

• Command + Option -drag (Mac) | Control + Alt -drag (Win) the pin to duplicate the adjustment. 

• Right -click (Control -click on Mac) the selected adjustment’s pin to select additional options from the context sensitive menu.

• Y toggles the visibility of the Mask overlay.  Shift+ Y  cycles through the different mask overlays (Color, Color Overlay on B&W, Image on B&W etc.).

• To temporarily display the mask overlay, hover the cursor on top of the adjustment tool’s pin in the image area or over the mask thumbnail in 

the Masks panel. When a mask contains multiple components (brush + graduated filter for example), hovering the cursor over the individual 

component’s mask will display the mask for that specific tool while hovering the cursor over the composite mask’s thumbnail will display the 

mask created by combining all of the individual components (tools) with in the mask.   

• V toggles the visibility of mask pins and tools.  In images that have more than one mask, Option + V (Mac) | Alt + V (Win) toggles Show Unse-

lected Mask Pins. 
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• To quickly select another mask (without having to use the Masks panel), press the “A” key to temporarily display the pins for unselected masks, 

and click on the desired mask pin. 

• To delete all masks, click the reset icon in the upper right of the Masks panel.

When using the Brush Tool (K):

•  “[“ or “]” (left/right brackets) decreases/increases brush size. Add the Shift key to decrease/increase the feather (edge softness). Or,  Control 

-drag left/right to decrease/increase the brush size. Control + Shift -drag left/right to decrease/increase the feather (edge softness).

• Flow sets the speed at which the brush applies the adjustment. Lowering the Flow amount enables a slower build up of an effect and can 

reduce the number of individual pins needed to modify an image as one can apply different amounts of the same adjustment in different 

areas without having to create a new pin for each different amount. Tap “+ “ (plus) or “-” (minus) to increase/decrease Flow. 

• Density caps the amount of the adjustment that can be applied (even with multiple strokes). Use the numeric keys on the keyboard to change 

the Density amount. Tapping one number assigns the percentage of the hit number (1 = 10%, 2= 20% etc. and 0 = 100%). Tapping two num-

bers quickly will give you that exact amount (5 + 4 = 54%).

• Hold Option (Mac) | Alt (Win) to toggle between the Brush and the Eraser. To keep the brush and eraser size the same, click the More icon (the 

three dots) at the top of the Brush panel and disable “Separate Eraser Size” .

• Shift -drag constrains the Brush to a straight line. Click once, then shift -click to have Camera Raw draw between the two points. Note: You can 

change brush attributes between the first and second clicks and Camera Raw will interpolate between the different settings. 

• Tap “W” to toggle the Auto Mask option (Auto Mask detects edges based on contrast and color to help apply adjustments to a selective area). 

• Camera Raw supports pressure-sensitive devices such as Wacom and Microsoft Surface Pro tablets. Pressure applied to the pen affects the 

Flow. Turning the pen over and using the “eraser” side automatically switches the brush to the eraser mode (if your pen supports this feature).

When using the Linear Gradient (G):

• Drag the center pin to reposition the gradient. Shift -drag the center pin to constrain the movement to the horizontal or vertical direction.

• Shift -drag the rotate icon snaps the rotation to 15-degree increments.

Tap “X” to reverse the direction of the linear gradient.

When using the Radial Gradient (J):

• Drag the center pin to reposition the gradient. Shift -drag the center pin to constrain the movement to the horizontal or vertical direction.

• Shift -drag constrains the gradient to a circle.

• Shift -dragging any of the four handles of an existing Radial Gradient will preserve the aspect ratio of the ellipse.

• Shift -dragging the boundary of an existing Radial Gradient constrains the rotation to 15-degree increments.

• You can drag a Radial Gradient beyond the image area.

• When first adding a Radial Gradient, double-click in the image area to set the bounding box of the Radial filter to “Fill” the image bounds. 

When using the Range Mask features:

• Tap Shift + C to select Color Range. Use the Color Range option to create a selection based on the colors in an image. To select the desired 

range of colors to adjust: 

- Click to sample a color. 

- Shift-click to sample up to 5 colors. 

- Shift-drag to sample an area of colors. 

- Option -drag (Mac) | Alt -drag (Win) the Refine slider to preview the targeted range as a greyscale mask in the image area.

• Tap Shift + L  to select Luminance Range. Use the Luminance Range option to create a selection based on the brightness values in an image. 

To select the desired range of values to adjust:

- Use the eyedropper tool to select a specific value.

- Use the eyedropper tool to drag-select a range of values.

- Use the Luminance Range interface (in the panel) and drag to resize and/or  reposition the rectangle to define the range that is being effected. 

The area within the rectangle will be fully adjusted. To avoid abrupt transitions between the areas that are adjusted and those that are not, drag 

the vertical line (the outer marker) to adjust the smoothness of the fall off (how quickly the selection transitions from the selected tonal range 

to the unselected range).

- Option -drag (Mac) |Alt -drag (Win) the in the Luminance range options to see the Luminance map in the image area (or enable Show Lumi-

nance Map in the panel track). 

• Tap Shift + D to select Depth Range. Use the Depth Range option to create a selection in an image based on the distance from the camera. 

Note: Depth Range is only available only for those photos that have embedded depth map data. As of now, this is limited to HEIC files captured on 
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Apple iPhone using the Portrait mode. If there is no available depth info for an image, the Depth Range option is disabled. To select the desired 

depth range to adjust:

- Use the eyedropper tool to sample a single area.

- Click-drag with the eyedropper to sample a depth range.

- Use the Depth Range interface to select the area to be masked. The area within the rectangle will be adjusted. To avoid abrupt transitions 

between the areas that are adjusted and those that are not, drag the vertical line to adjust the fade range.

The following shortcuts can be used to navigate the Masks panel:

• Option + up/down arrow (Mac) | Alt + up/down arrow (Win) targets the mask above/below. When you reach the top or bottom of the list, it 

will wrap around. If a mask only has a single component, it will be selected automatically.

•  If a mask has more than one component, use Option + right Arrow | Alt + right arrow (Win) to select the first component. Then, use Option 

+ up/down arrow (Mac) | Alt + up/down arrow (Win) to move through the components

•  Deselect the selected mask or component  by pressing Option + left arrow (Mac) | Alt + left arrow (Win).

• Hold Option + Y (Mac) | Alt + Y (Win) to temporarily enable the mask overlay for the currently selected mask component. Note: this shortcut 

can be combined with the up/down arrow keys to display the mask overlay while targeting different masks.

When copying and pasting masks: 

• When you copy and paste a mask to a different image, if the destination image has any masks, you will have the option to Merge the masks 

(add the pasted masks to the existing masks) or replace the masks (deleting any existing masks).

• When copying/pasting AI driven masks (Select Subject, Sky, Background, Objects, and People) masks from one image to another, the masks 

will be recomputed automatically.

Saving Masks as presets

• Masks can be saved in presets. AI driven masks (Select Subject, Sky, Background, Objects, and People) will be recomputed automatically.

• When presets that include masks are applied to images, the masks are additive (they won’t replace existing masks).

• Masks that include AI/ML masks (Select Subject, Sky, Background, Objects and People can not be applied as Raw Default Settings. 

21. Snapshots Panel
• Shift + S displays the Snapshots panel. 

• Command + Shift (Mac) | Control + Shift (Win) creates a new Snapshot. A Snapshot “captures” all of the edits applied to an image and saves 

them as a single entry in the Snapshot panel. You can then take the image in another direction with the security of knowing that you can 

quickly return to the Snapshot “state” with a single click. 

• Snapshots are available when the file is opened as a Smart Object into Photoshop (making it easy to quickly move between different edits of 

the same image when designing a layout or making a multi-image composite). 

22. Red Eye Removal Tool
• Shift + E selects the Red Eye Removal tool.

• The Red Eye tool can also correct bright pupils in animals. For Type, select Pet Eye and use the Pupil slider and Catchlight options as desired.

23. Presets Panel
• Shift + P displays the Preset panel. Presets are stored by default here:

- Windows: Win (user)/Application Data/Adobe/Camera Raw/Settings.

- Mac: Mac (user)/Library/Application Support/Adobe/Camera Raw/Settings. Note: on Mac, hold the Option key down while selecting the “Go” 

menu in the Finder to reveal the Library folder.

• To update a preset, make the desired changes to an image, then  Control -click (Mac) | right-click (Win) on the preset in the Preset panel and 

choose “Update with Current Settings”. 

• Control -click (Mac) | right -click (Win) on a custom preset to access a wide variety of options (Preset Info, Add to Favorites, Rename Preset, 

Manage Presets, Import Profiles & Presets and more).

• Control -click (Mac) | right -click Win on a preset to select it as a Raw Default for all raw files or a specific Camera model.

• Hover the cursor over a preset and click the Favorite (star) icon to add it to the Favorites group at the top of the Presets panel. 

- Favorites can be quickly applied to images in Adobe Bridge by selecting Edit > Develop Settings > Preset xxx. 

- Setting can also be removed in Bridge (Edit > Develop Settings > Clear Settings). 

• Masks can be saved in presets. AI driven masks (Select Subject, Sky, Background, Objects and People) masks will be recomputed automatically. 

If there are masks in the image prior to adding a preset, the masks will be merged.
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• When presets that include masks are applied to images, the masks are additive (masks will always be added, they won’t replace existing masks).

• Masks that include AI/ML masks (Select Subject, Sky, Background, Objects and People can not be applied during the Import process nor in 

the Raw Default Settings. 

• When creating Presets, check “Support Amount Slider” to enable the strength of the preset to be decreased/increased. 

24. Color Sampler Tool
• Tap the S key to select the Color Sampler tool. Click in the image area to add a maximum of 9 Color Samples per image. 

• Option -click (Mac) | Alt -click (Win) on a color sample to delete it (the icon changes to a pair of scissors). 

• With the Color Sampler tool selected, click the Reset icon (on the Sample Info bar) to remove all Color Samplers at once.

• With the Color Sampler tool selected, press and hold the Shift key to temporarily access the White Balance tool.

25.  Grid Overlay
• Shift + G toggles a grid over the image. 

• Use the Grid Size and Opacity settings that appear at the top of the screen to customize the grid or, [ and ] decreases/increases the grid size; 

add the Shift key to decreases/increases opacity.  

26. Soft Proofing
• Camera Raw includes the ability to select RGB, CMYK and LAB ICC profiles to soft proof images. To select a profile, click the Workflow Options 

hyperlink at the bottom of the Camera Raw window and, in the Color Space section, choose the desired profile from the pop-down menu. 

Once a profile is selected, Camera Raw displays a “soft proof” of that image. In addition you have the ability to choose either Perceptual or 

Relative as your rendering Intent and can choose whether or not to Simulate Paper and Ink. There is not an option for Black Point Compen-

sation because it is always enabled in Camera Raw. 

• Grayscale color profiles are only displayed when processing a monochrome image or when converting a color image to grayscale. 

• When using a Lab or CMYK color space, the histogram and color readouts will change accordingly. 

• For accurate results, monitor calibration is a must! In addition, there may very well be some colors that simply aren’t reproducible on a monitor 

that can be printed and vice versa.

27. Before and After Previews Options
• To toggle the visibility of the edits made on a single panel, click and hold the Per-Panel Preview icon (the eye). Note: if the icon is grayed out, 

changes have not been made within the panel.   
• Click the Cycle between Before/After Views button to cycle through left/right and top/bottom side-by-side and split-view modes.

- Tap Q to cycle through the Before/After Views.
- Click-and-hold the Before/After icon to quickly select a specific Preview mode from the menu.
- Click-and-hold the Before/After icon to access and customize Preview Preferences.

• Click the Swap Before/After settings button to swap settings.
- Tap the P key to swap Before/After settings for the primary selected image only. 

• Click the Copy button to copy the After settings to the Before settings (useful for establishing a temporary “checkpoint” for an editing session).

- Option + P (Mac) | Alt + P (Win) copies After settings to the Before settings for the primary selected image only.

- Option + Shift + P (Mac) | Alt + Shift + P (Win) copies After settings to the Before settings for all selected images.

28. Save Image Options
• Command + S (Mac) | Control + S (Win) displays the Save Options window. 

• Option -click (Mac) | Alt -click (Win) the Save icon to save the selected images using the last applied settings (bypassing the Save Options dialog).

• Use the Preset menu to save presets for frequently used Save settings. 

- Control -click (Mac) | right -click (Win) to apply Save presets via the context sensitive menus.

29. Workflow Options
• Before opening files into Photoshop, click the hyperlink at the bottom of the window to choose Workflow options including Color Space, 

Image Sizing, Output Sharpening, and Photoshop options.

• Save frequently used settings as presets using the Presets menu at the top of the Workflow Preferences. Control -click (Mac) | right -click (Win) 

the workflow hyperlink to quickly switch between workflow presets. 
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• Command + O (Mac ) | Control + O (Win) opens the image.

- Command + Option + O  (Mac ) | Control + Alt + O (Win) opens a copy.

- Command + Shift + O (Mac ) | Control + Shift + O (Win) opens as a Smart Object.

• Hold the Option (Mac) | Alt (Win) to toggle Open to Open Copy (useful for opening multiple copies of the same file processed in different ways).

• Hold the Shift key to toggle Open to Open Object to open an image in Photoshop as a Smart Object without having to edit the Workflow 

options. Note: if the Workflow settings are set to Open as Smart Object, the Shift key will toggle from Open Object to Open. 

• Holding the Option (Mac) | Alt (Win) key toggles Cancel to Reset”. Click Reset to revert the image settings to the beginning of the session (this 

may or may not be the camera defaults if it’s not the first time the image is opened in Camera Raw). 

• Within Image Sizing, use the Width & Height option to resize using both the image width and height. The width of the resized image will be 

limited to the unit specified in the “W” field, and the height of the resized image will be limited to the unit specified in the “H” field. Use the 

Dimensions option (which is similar to the “Width & Height” described above), but it disregards the image orientation. That is, the longer edge 

of the resized image will be limited to the larger of the two specified units. Similarly, the shorter edge of the resized image will be limited to 

the smaller of the two specified units.

30. Enhance Details and Super Resolution
• To access Enhance Details and  Super Resolution, right-click in the image, select it from the Filmstrip’s drop-down menu, Control -click on Mac) 

and choose “Enhance” or, use the shortcut Command + Shift + D (Mac) | Control + Shift + D (Win). In order to apply either of these features, 

Camera Raw will need to create a new DNG file. Note: All metadata and edit setting will be included in the new file

• Apply Enhance details on images captured using both Bayer and X-Trans sensors in order to improve the rendering of small-scale details 

and to prevent artifacts such as false colors, moirés, and zippering. On images captured using Bayer sensors (like those on Canon, Nikon and 

Sony), you will most likely find diagonal lines to be rendered cleaner (less jaggy). On images captured with X-Trans sensors (such as the Fuji 

X-series) you will most likely find improved small-scale detail and color accuracy (fewer artifacts).

• Apply Super Resolution to intelligently boost the resolution (2x width and 2x height for a 4x total pixel increase) of an image while maintaining 

clean edges and preserving important details.

• To skip the Enhance Preview dialog box, press Option (Mac) | Alt (Win) before rt-clicking and selecting the Enhance menu command (when 

using this shortcut, Camera Raw will apply the previously used settings).

• Camera Raw has a file size limit of 65,000 pixels on the long side or 500 megapixels. So, you may not be able to apply it to a really large file 

such as a panorama, since doubling the pixel dimensions of the panorama may exceed the limits of Camera Raw.  

• You can’t apply Super Resolution multiple times to the same original. Although you can apply Super Resolution and then enlarge the file 

further when using the Save options in Camera Raw or after opening the file in Photoshop (using the Image Size command).

• Applying Super Resolution to a Bayer or X-Trans raw file will also automatically apply Enhance Details, to create the highest quality image possible. 

31. Syncing Edits Across Images
• To make changes to multiple images at once, select them in the filmstrip. 

- Command + A (Mac) | Control + A (Win) selects all images. 

- Command +Option + A (Mac) | Control + Alt + A (Win) selects all rated images.

- Command + D (Mac) | Control + D (Win) deselects all but the “most selected” image (the one that you’re viewing in the image area)

- With multiple images selected, Option -click (Mac) | Alt -click (Win) the thumbnail of a selected image to make it the active image while keeping 

all of the other images selected. 

•  To quickly copy and paste edit settings from one image to the next, select the edited image in the filmstrip and use the shortcut Command + 

C (Mac) | Control + C (Win). Then, select the desired image and use the shortcut Command + V (Mac) | Control + V (Win) to paste the settings. 

For more control over which settings are copied, use the shortcut Command + Option + C (Mac) | Control + Alt + C (Win) to display the Copy 

Edit Settings dialog. Note: the Copy Edit settings can also be accessed from the context sensitive menus (Control -click (Mac) | right -click (Win) in 

the image area or on a thumbnail in the Filmstrip, and choose Copy Edit Settings/ Copy Selected Edit Settings).

• With multiple images selected, Option + S (Mac) | Alt + S (Win) displays the Synchronize dialog (enabling you to choose what settings to 

synchronize). Add the Shift key to bypass the dialog.

• With multiple images selected, moving a slider will set the same value for each image. However, some settings will be applied based on the 

image content including: Lens Correction (Remove Chromatic Aberration and Enable Profile Corrections) Auto Upright Modes, Auto Tone, 

and Auto Black and White Mix. Note: to apply the same numeric settings across all selected images, apply the settings the first image, then 

choose Sync from the filmstrip’s drop-down menu and choose the items to be synchronized (White Balance, Exposure, Contrast, etc.). 
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32. Merge to HDR 
• To merge multiple exposures to a single HDR images, select the images in the filmstrip, click the More icon and select Merge to HDR or, use 

the shortcut Option + M (Mac) | Alt + M (Win).

• Before running Merge to HDR, in the Optics panel, enable (check) Remove Chromatic Aberration and Lens Corrections and apply spot cor-

rections to the source images before merging (this is useful if there are spots that occur in the same spot in every image (dust on the sensor, 

for example); fix the spot in one, sync the spot corrections to the others, then merge).

• Not all adjustments made to individual images carry over when selecting Merge to HDR. For example, if you have made local adjustments 

on individual exposures, those adjustments will not be applied to the merged file. Because of this, I would suggest that you don’t spend a 

great deal of time making adjustments to each of the individual exposures but instead, merge the images and then make adjustments to 

the resulting RAW, HDR image. 

• If you make adjustments to an individual exposures that can be copied over to the merged file (such as conversion to B/W or Split Toning 

adjustments) , make sure that the exposure with the adjustments is the active or “most selected” image before running Merge to HDR. 

• Tap the A key to toggle the Align Images feature.

• Tap the T key to toggle Auto Tone.

• Tap the Y key to show the Deghost Shadow Overlay. 

• HDR merging requires exposure metadata. If aperture and ISO information is available, then it is used as well. Camera Raw will show an error 

if you try to merge photos of different sizes, focal lengths, etc.

• Option + Shift + M (Mac) | Alt + Shift + M (Win) will run Photo Merge > HDR based on the last used Merge settings (bypassing the dialog).

• By default Camera Raw appends the resulting image’s file name with -HDR. 

• The resulting (merged) HDR files will always default to the current Process Version.

33. Merge to Panoramas
• To stitch multiple exposures to a single panorama, select the images in the filmstrip, click the More icon, and select Merge to Panorama or, 

use the shortcut Command + M (Mac) | Control + M (Win).

• Before running Merge to Panorama, enable (check) Remove Chromatic Aberration and apply spot corrections to the source images before 

merging (this is useful if there are spots that occur in the same spot in every image (dust on the sensor, for example); fix the spot in one, sync 

the spot corrections to the others, then merge).

• Not all adjustments made to individual images carry over when selecting Merge to HDR. For example, if you have made local adjustments 

on individual exposures, those adjustments will not be applied to the merged file. Because of this, I would suggest that you don’t spend a 

great deal of time making adjustments to each of the individual exposures but instead, merge the images and then make adjustments to 

the resulting RAW, HDR image. 

• If you have made adjustments to the individual images prior to choosing Merge to Panorama, not all of them carry over to the merged file. 

For example, if you have made local adjustments on individual exposures, those adjustments will not be applied to the merged file. Because 

of this, I would suggest that you don’t spend a great deal of time making adjustments to each of the individual exposures but, instead, merge 

the images and then make adjustments to the resulting Panorama image. Note:  For a Panorama, the merge tool is changing geometric attri-

butes, and will therefore not copy over existing geometric settings such as Lens Corrections/Upright (with the exception of Chromatic Aberration 

and Defringe settings).  

• If you make adjustments to an individual exposures that can be copied over to the merged file (such as conversion to B/W or Color Grading 

adjustments) , make sure that the exposure with the adjustments is active or “most selected” image before running Merge to Panorama. 

• Command + 1/2/3, (Mac) | Control + 1/2/3 (Win) will quickly select different projection options (1=Spherical, 2=Perspective, 3=Cylindrical).

• Tap the C key to enable Auto Crop.

• Use the Boundary Warp slider to adaptively stretch or reshape the edges of a stitched panorama to fill the rectangle boundary.

• Command + Shift + M (Mac) | Control + Shift + M (Win) will run Merge to Panorama based on the last used settings (bypassing the dialog).

• By default Camera Raw appends resulting image’s file name with -Pano. 

• There is a size limit of 65,000 pixels on the long side of a file or, 512 MP - whichever comes first.

• The resulting Panorama will always default to the current Process Version.

34. Merge to HDR Panoramas
• Lens Correction Profiles are applied if Camera Raw can auto-detect which profiles to use. If Camera Raw can’t auto-detect the correct profile, an 

alert appears asking you to apply a lens profile correction for best results. Camera Raw always remove chromatic aberration as part of the merge.
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• If you make adjustments to an individual exposures that can be copied over to the merged file (such as conversion to B/W or Color Range 

adjustments), make sure that the exposure with the adjustment(s) is the active or “most selected” image before running Merge to HDR Panorama. 

• If there are spots that occur in the same location in every image (dust on the sensor, for example), you can fix them in one exposure, sync the 

spot corrections to the others, then merge  the files and Camera Raw will apply the spot corrections to the source images before merging.

• To use the Deghost feature, bracketed exposures must be merged independently (Merge to HDR… ) and then stitched (Merge to Panorama…).  

• Camera Raw saves the final Panorama (with the suffix HDR-Pano ), and discards the intermediate HDR images.

35. Camera Raw Preferences 
• Command + K (Mac) | Control + K (Win) displays the Camera Raw Preferences.

• Preferences > Performance—When moving back and fourth between multiple images, it can be a performance advantage to increase the 

Camera Raw Cache when working with raw files. The larger the cache, the greater the number of images Camera Raw can hold onto for quick 

access - making it faster to load recently viewed images. If you are simply moving from one image to the next (without returning to the pre-

viously viewed images), then you may not see a benefit from increasing the Camera Raw Cache. 

36. Using Camera Raw without Photoshop
• For most people, the fact that Camera Raw is a plug in that works in both Bridge and Photoshop is completely transparent. The most common 

workflow is to find the desired image in Bridge, double click to open it in Camera Raw and start making edits. When finished editing, clicking 

the Done button will close Camera Raw and leave you in Photoshop. If, instead, after selecting images in Bridge, you choose File > Open in 

Camera Raw, click the Open in Camera Raw icon, or Command+ R (Mac) | Control + R (Win), Bridge launches the Camera Raw plug-in so that it 

runs within Bridge (not Photoshop). The advantage to this workflow is that you can make edits using Camera Raw without having Photoshop 

open and, when you are finished making edits in Camera Raw, clicking the “Done” button, returns to Bridge. 

37. Bypass Camera Raw when Opening From Bridge
• Shift-double clicking on a RAW image in the Bridge will bypass the Camera Raw dialog, applying either settings that have been saved with 

the file, or if there are no setting applied, opening the file with the camera defaults into Photoshop.

38. Applying Camera Raw Presets in Bridge
• To apply a Camera Raw preset to an image in Bridge, first create the preset in Camera Raw and, in the Preset panel, click the star icon to the 

left of the preset name to Add to Favorites. The next time you want to apply the preset, select the file(s) in Bridge, Control -click (Mac) |  Right 

-click (Win) and choose Develop Settings > your preset from the context sensitive menus.


